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Getting Started 
Using LCD Icons 

The Cisco IP Phone 7960 provides cues about its current status on the LCD 
screen. Often, the icons on the screen change depending on the task you are 
currently performing with the Cisco IP Phone. 

Using the IP Phone Configuration Utility 

The Cisco CallManager enables you to make changes to your phone using your 
desktop computer and a web browser. You can use this utility to configure speed 
dial and change your password.   

You can access the Cisco CallManager through the following link: 

http://www.saddleback.edu/itc/ITCIPP.html

Once on this site, select the Cisco CallManager Logon Page link and you will be 
connected to the utility.  Your logon will be the same as your computer logon.  
The temporary password is 123456. 

Tips 

These tips assist you in becoming more familiar with the Cisco IP Phone: 

• When accessing the Cisco IP Phone options, note the number listed next 
to the option. You can simply enter this number using the dialing pad to 
quickly access a feature.  

• Explore your phone by experimenting with the different functions and 
observing their behavior. Use the user guide for instructions or refer to 
online help if you are not sure what to do next.  

• The more soft key indicates that more options are available in a particular 
menu. Press it to see the additional options. 

• When making an external call, always dial “9+1+area code+number”. 

 

 

 

Cisco IP Phone Model 7960                                                                                                                                                                    3 

http://www.saddleback.edu/itc/ITCIPP.html


How to Use the Handset, Speakerphone, and 
Headset 
You can place and answer calls with the handset, speakerphone, or a headset. 
These sections describe their use and how to adjust the volume of the call: 

Using the Handset 

To place and answer calls with the handset, simply lift the handset. To change 
from handset to speakerphone, press SPEAKER  and hang up the handset. 

Using the Speakerphone 

To place and answer calls using the speakerphone, press SPEAKER . You can 
use the speakerphone with all Cisco IP Phone 7960 features. To change from 
speakerphone to handset, lift the handset. 

Using the Headset 

To place and answer calls using the headset, plug the approved headset into the 
back of the phone base and press HEADSET . 

You can use the headset with all Cisco IP Phone 7960 features. The Volume and 
Mute controls also adjust volume to the earpiece and mute the speech path of 
the headset. The headset activation key is located on the front of the phone. 

The Cisco IP Phone 7960 supports a four- or six-wire headset jack (Plantronics H 
series compatible is required. In addition to the headset, you will need to order 
the compatible cord- Product. No. 26716-01). For information on the exact 
models supported, go to http://www.cisco.getheadsets.com.   

 Adjusting the Handset, Speakerphone, and Headset Volume 

To adjust the volume on the handset, speakerphone, or headset: 

 
Step 1   To increase or decrease the volume of your handset, headset, or 
speakerphone, press the up or down volume button.  

The volume buttons adjust the volume for the currently active voice receiver. 

Step 2   To save the volume setting for future calls, press the Save soft key. 
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Customizing Phone Settings 
You can change various settings on your Cisco IP Phone 7960 to ensure that the 
ringer volume, ring sound, and LCD contrast are set appropriately for you. These 
sections describe the changes you can make: 

 

Adjusting the Ringer Volume 

To change the volume used by the ringer: 

Step 1   Press the volume key to hear a sample ring.  

Step 2   While the ring plays, press the up or down volume key to adjust the 
volume to the desired level. 

Step 3   To save the ring volume setting, press the Save soft key. 

 

Changing the Ringer Sound 

To change the sound used by the ringer: 

 
Step 1   Press the settings  button.  

Step 2   Select Ring Type from the Settings menu.  Press the Select soft key. 

Step 3   Select Default Ring and press the Select soft key. 

Step 4   To scroll through the list of ring types, press the scroll key. 

Press the Play soft key to hear the selected ring type. 

Step 5   When you find the ring you want, press Select and then press the OK 
soft key. 

Step 6   Press the Exit soft key twice to save your selection and exit the Settings 
menu. 
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Changing the LCD Contrast 

To improve the readability of the LCD, change the amount of contrast: 

 
Step 1   Press the settings  button.  

Step 2   Select Contrast from the Settings  menu and press the Select soft 
key. 

Step 3   Press the Up or Down soft keys or the volume keys to set the desired 
intensity of the display. 

Step 4   Press the OK soft key to accept your changes. 

Step 5   To save this contrast setting, press the Save soft key and exit the 
Settings  menu. 

 

Making Telephone Calls 
Placing a Call Using a Telephone Number 

You can place a call with the Cisco IP Phone 7960 in any of the following ways: 

• Lift the handset and dial the number.  
• Press the NewCall soft key and dial the number.  
• If using a headset, press HEADSET  and dial the number.  
• To use the speakerphone, press SPEAKER  and dial the number.  
• Enter a phone number and select the Dial soft key. 
• If you have a speed dial list, you can select the speed dial number and 

select the AbbrDial soft key. 

 

Answering a Call 

You can answer a call using the handset, headset, or speakerphone. 

• To use the handset, lift the handset.  
• To use a headset, press HEADSET , and press the line button of the 

incoming call.  
• To use the speakerphone, press the Answer soft key or the SPEAKER  

button. 
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Call Waiting 

The Cisco CallManager version of the Cisco IP Phone 7960 allows you to answer 
an incoming call while on another line.   

Step 1 During an active call you will hear a beep signaling an incoming call. The 
incoming call will be viewable on your phone screen.  You may choose not to 
answer the call and allow it to roll over to voicemail.  

Step 2 Press the Answer soft key and your 1st line will automatically be placed 
on hold. 

Step 3 After completing the call press Resume and you will be connected to the 
1st line.  

 

Note:   You may toggle between the two lines by using your up & down scroll 
button highlighting each call and pressing Resume.   

 

Ending a Call 

To end a call: 

• If using the handset, hang up the handset or press the EndCall soft key.  
• If using the headset, press the EndCall soft key. This method also works 

for all speaker modes.  
• If using the speakerphone, press SPEAKER . 

 

Muting a Call 

While on a call, you can mute the handset, headset, or speakerphone, preventing 
the party you are speaking to from hearing what you or someone else in the 
room is saying. 

• To mute a call, press MUTE .  
• To disengage mute, press MUTE   again. 
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Placing a Call on Hold 

While on a call, you can place the call on hold, so that the caller cannot hear you 
and you cannot hear the caller. You can answer other calls while a call is on 
hold. 

• To place a call on hold, press the Hold soft key.  
• To return to the call, press the Resume soft key. If multiple calls are on 

hold, use the scroll key to select the desired call before you press 
Resume.  

• If multiple calls on multiple lines are on hold, press the line button for the 
line to which you want to switch and use the scroll keys to select the 
desired call before you press Resume. 

 

Transferring a Call 

To transfer a call to another phone: 

 
Step 1   During a call, press the Trnsfer soft key. This places the call on hold.  

Step 2   Dial the number to which you want to transfer the call. 

Step 3   When it rings on the other end, press Trnsfer again, or when the party 
answers, announce the call and press Trnsfer.  This will automatically 
disconnect you from the call. 

If the party refuses the call, press the Resume soft key to return to the original 
call. 

 

Redialing the Last Number Dialed 

To redial the most recently dialed number, lift the handset and press the Redial 
soft key. Alternatively, you can simply press Redial to activate the speakerphone 
or headset. 

To redial the most recently dialed number from a line other than your primary 
line, select the desired line button and then press Redial. 
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Parking a Call 

The Cisco CallManager version of the Cisco IP Phone 7960 allows you to store 
or "park" a call at a specified number and then use any other phone in the Cisco 
CallManager system (for example, a phone in someone else's office or in a 
conference room) to retrieve the call. Call Park numbers are configured by your 
system administrator.  

 
Step 1   During an active call, press the more soft key until you see the Park tab.  

Step 2   Press Park. The display shows the number to which the call is parked. 

Step 3   Make a note of the Call Park number and then hang up. The call is now 
parked at that number, allowing you to retrieve it from another phone. 

Step 4   To retrieve the parked call from any phone in the Cisco CallManager 
system, dial the Call Park number at which the call was parked. 
 

 
 Note   You have a limited amount of time to retrieve the parked call before it 
disconnects.  

 

Using Call Pickup 
The Cisco CallManager version of the Cisco IP Phone 7960 allows you to answer 
a call that comes in on a telephone extension other than your own.  When you 
hear an incoming call ringing on another phone, you can redirect the call to your 
phone using the call pickup features. 
 
Call Pickup and GroupPickup are optional features configured by the system 
administrator and your phone does not support these by default. You will be 
notified if you are placed in a Pickup group. 
 
There are two types of call pickup available on the Cisco IP Phone: 

• Call Pickup – pick up incoming calls within your own group. The 
appropriate call pickup number is dialed automatically when you choose 
this feature. 

• Group Call Pickup – pick up incoming calls within your own group or in 
other groups. You must know and dial the appropriated call pickup group 
number when using this feature. 
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Picking up Calls in Your Group 

Call Pickup allows you to pick up incoming calls within your own group. When 
you activate Call Pickup, it automatically dials the calls group number associated 
with the line you selected on your phone. If there is a call coming in on another 
telephone number in that same group, the call immediately begins ringing on 
your line. If there is more than one incoming calls in the pickup group, then you 
receive the first unanswered call.  If there is no unanswered call in the group 
when you activate Call Pickup, your phone is placed back on hook. 

Step 1 Press the line button and the more soft key. 

Step 2 Press the PickUp soft key. 

Step 3 Answer the incoming call that is redirected to your phone. 

 

Picking Up Calls Outside Your Group 

Group Call Pickup allows you to pick up incoming calls within your own group or 
in other groups. You must dial the appropriate call pickup group number when 
using this feature. 

If there is a call coming in on another telephone number in the call pickup group 
you dialed, that call immediately begins ringing on your line. If there is more than 
one incoming call in the pickup group, then you receive the first unanswered call. 
If there is no unanswered call in the group, or if you dial an invalid call pickup 
group number, you receive a fast busy tone. 

Step 1 Press the line button. 

Step 2 Press GPickUp soft key. 

Step 3 Dial the desired call pickup group number. 

Step 4 Answer the incoming call that is redirected to your phone. 

Step 5 To dial a different call pickup group number, hang up and begin again. 
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Making Calls from the Directory 
The Cisco IP Phone 7960 maintains a directory of calls you miss, receive, and 
place. You can use this directory to locate numbers you want to redial. You can 
also use a corporate directory to quickly locate and call co-workers in your 
company.  

Viewing or Dialing Missed Calls 

If your phone display indicates you have missed calls, you can use the Missed 
Calls option on the Directory menu to view call history and call back the missed 
call. 

 
 
Step 1   Press the directories  button.  

Step 2   Press the Select soft key to select Missed Calls from the Directory 
menu. 

The call history for missed calls is displayed on the LCD. 

Step 3   If desired, click the Dial soft key to speed dial a number from the missed 
call list.  You can also pick up the handset or press the speaker button and the 
number will be dialed. 

You might need to use the EditDial soft key to add digits to the front of the 
number. For example, if the call was from an outside, long-distance caller, you 
might need to add the digits "91" to the front of the number. 

Step 4   Press the Exit soft key twice to exit the Directory menu. 

 

Viewing or Dialing Received and Placed Calls 

The Cisco IP Phone 7960 keeps a history of all calls you make and receive, 
including the caller ID, time, and date of the call. You can use this information to 
redial a party. 

 
 
 
Step 1   Press the directories  button.  
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Step 2   Use the scroll key to select the desired call history option: Missed Calls, 
Received Calls, Placed Calls. 

Step 3   Press the Select soft key to display the call history list. 

Step 4   If desired, press the Dial soft key to speed dial a number from the call 
history list.  You can also pick up the handset or press the speaker button and 
the number will be dialed. 

You might need to use the EditDial soft key to add digits to the front of the 
number. For example, if the call was from an outside, long-distance caller, you 
might need to add the digits "91" to the front of the number. 

Step 5   When you are finished, press the Exit soft key twice to exit the Directory 
menu. 

 

Making Calls from a Corporate Directory 

The Cisco CallManager version of the Cisco IP Phone 7960 can access a 
directory of employee names and phone numbers. You can access a corporate 
directory to quickly find and call a co-worker.  

To access a corporate directory: 

 
Step 1   Press the directories  button.  

Step 2   Use the scroll key to select Corporate Directory. 

Step 3   Press the Select soft key to display the directory search options. 

Step 4   Use the scroll key to select the search option: First Name, Last Name, 
Number. 

Step 5   Use the numbers corresponding to the letters on the dialing pad to enter 
a name or number to find in the directory and press the Search soft key. 

Step 6   If necessary, scroll until the desired number is highlighted. 

Step 7   If desired, press the Dial soft key to speed dial a number from the 
corporate directory. 
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Using Call Forwarding 
The Cisco CallManager version of the Cisco IP Phone 7960 includes call 
forwarding, which allows you to redirect calls made to your telephone to another 
phone. This is useful if you know you will be away from your desk for several 
days, for example, on a business trip or a vacation. 

The Cisco CallManager version of the Cisco IP Phone 7960 enables you to 
forward all incoming calls to another number. You can forward all calls to an IP 
phone or non-IP phone. 

To forward calls: 

 

Step 1   Press the CFwdAll soft key. You should hear two beeps.  

Step 2   Enter the number to which you want to forward all your calls. A flashing 
right arrow appears in the upper-right corner of the LCD, indicating that all calls 
are being forwarded. The LCD also displays a message with the number to which 
your calls are being forwarded.  If you want to forward your calls to voicemail, 
press the CFwdAll soft key and press the messages  button. 

 
 Note   Be sure to enter the number with “9+1+area code+number if you are 
forwarding to an external number (if this option is available to you). 

 

To cancel forwarding of all calls, press the CFwdAll soft key. You should hear 
two beeps and see that the flashing arrow no longer displays in the upper-right 
corner of the LCD, indicating that call forwarding is not active.  

 

Making Conference Calls 
The Cisco IP Phone 7960 supports conference calls, enabling you to conference 
with 7 (seven) calling parties.  

Placing a Conference Call 

To turn a call into a conference call: 
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Step 1   During a call, press the more soft key and then the Confrn soft key. 
This will automatically select a new line and place the other party on hold.  

Step 2   Place a call to another number. 

Step 3   When the call connects, press Confrn again to add this party to the 
conference call. 

You can repeat these steps to add parties to the conference call.  

Conference Call Tips 

• To end a conference call, all but one party must hang up.  
• Once the conference call initiator disconnects, no additional parties can be 

added.  
• To place a conference call on hold, press the Hold soft key. The other 

parties can talk among themselves but they cannot hear you.  

Keep in mind when you put a call on hold, a beeping tone automatically 
generates every few seconds. To avoid disrupting the other callers, 
consider muting the call instead. To mute the call, press the MUTE 
button. 

• To place a conference call on speakerphone, press SPEAKER . Press 
MUTE  to mute the speakerphone. The conference parties cannot hear 
you but you can hear them.  

• If you are using the Cisco CallManager version of the phone, press the 
Trnsfer soft key to transfer a conference call to another person. Dial the 
number to which you want to transfer the call and then press Trnsfer 
again. All parties will be transferred. 
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Cisco CallManager Attendant Console 
Cisco CallManager Attendant Console provides the ability to manage phone 
queues.  There are three types of phone queues set up at Saddleback: 

• Circular Queue: This mode directs calls in a circular mode, following the 
same pattern for all calls.  For example, a circular queue group of five will 
receive calls in the following order: 1 – 2 – 3 – 4 – 5 – 1 – 2 – 3 – 4 – 5 – 1 
and so on.   If one of the circular queue members is offline or on a call, the 
call order will skip to the next person in order and continue in the circular 
mode. 

• First Available Queue: This mode directs calls to the first available 
attendant.  For example, the first available person in a group of five will 
receive the first call, the second will receive the second call, and so on. 

• Broadcast Queue:  This mode places all calls into a broadcast group. 
Available attendants can answer calls from that group and handle the call 
on their line.  There is no prioritization of routing as in the Circular or First 
Available modes. 

 
 Note   A phone queue attendant must be logged in and online to be able to 
receive calls. 

 

The ability to answer phones using Attendant Console depends on the way in 
which your department wants to handle calls. If your department wants calls 
answered between 8:00 a.m. & 5:00 p.m., for example, the Auto Attendant 
function will only route calls to the queue during those hours.   
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Logging into Attendant Console 
If you are a member of a phone queue, you will have Cisco CallManager 
Attendant Console loaded onto your desktop.  To log on: 

Step 1   Double click on the Cisco CallManager Attendant Console icon.  The 
following Log In screen appears:   
 

   
 
Step 2   Log in using the userID and password that was provided to you. Click on 
Log In.  The following screen will appear: 
 

 
 
Step 3   Make sure you are online.  To do this, select File>Go Online from the 
menu bar.  You can also select the Go Online icon from the Call Handling bar. 
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Setting Your Preferences 
You can modify the font size on your screen and change the color scheme for 
Attendant Console.  To modify either of these, go to View from the menu bar.  
Select either Text Size or Color Schemes.  Choose your preferences from the 
choices that are made available. 

You can also lock your windows so that they cannot be minimized or maximized.  
To access this feature, go to View>Lock Windows from the menu bar. 

If you want to use keyboard shortcuts for commands, go to Edit on the menu bar.  
Go to Keyboard Shortcuts and select a menu command to see its shortcut.  
You have the option of customizing shortcuts to meet your needs by choosing 
Edit>Keyboard Shortcuts from the menu bar. 

Answering Calls from Attendant Console 
The way in which you handle calls depends on the type of queue group in your 
office.  Your department selected the type of group to best meet its needs. 

Answering Calls in Circular Mode 

When a call comes into a Circular queue, it will rotate between the attendants in 
a circular motion.  When a call rings on your Attendant Console, it will appear in 
the Call Control box.  The call will also ring on your phone.  To answer the call, 
answer the phone or select the Answer icon on the Call Handling bar.  It is 
recommended that you use a headset. 

If all agents are offline or logged off, the caller will be put in hold until an agent 
becomes available.  A call may be transferred to voicemail after holding for a 
period of time, depending upon the configuration design of your department. 

Answering Calls in First Available Mode 

When a call comes into a First Available queue, it will ring on the phone of the 
first available agent.  The call will also appear in their Call Control box.  To 
answer the call, answer the phone or select the Answer icon on the Call 
Handling bar.  It is recommended that you use a headset. 

If all agents are offline or logged off, the caller will be put in hold until an agent 
becomes available.  A call may be transferred to voicemail after holding for a 
period of time, depending upon the configuration design of your department. 
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Answering Calls in Broadcast Mode 

When a call comes into a Broadcast queue, the call will not ring on any queue 
attendant phone.  The caller will be placed on hold and continue to hold until an 
agent selects the call to answer.  The call will be displayed in the Broadcast 
Calls box.  To answer the call, double click on the call you want to answer in the 
Broadcast Calls box and select the line on which you want to take the call.  You 
can also select the call to answer and click on the Answer icon on the Call 
Handling bar.  It is recommended that you use a headset. 

 
 Note   It is recommended that you select the first call in the Broadcast Calls 
box to ensure that you answer the caller who has been on hold the longest. 

 

If all agents are offline or logged off, the caller will be put in hold until an agent 
becomes available.  A call may be transferred to voicemail after holding for a 
period of time, depending upon the configuration design of your department. 

Call Handling from Attendant Console 
You can perform a variety of functions from the Attendant Console screen on 
your desktop.  To invoke these commands, press the icon on your desktop that 
corresponds with the command you want to perform. 

Call Control 
Buttons  Call-Control Tasks  

 

 

Offline/Online  
Note This Call Control button toggles, allowing you to click the same button to 
perform the two call-control tasks.  
  

 

Dial 
Selecting this button brings up a screen which allows you to enter the desired 
number or search from a directory list and place a call from the list. 
  

 

Answer 
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Hang Up 
 
  

 

 

Hold/Resume  
Note This Call Control button toggles, allowing you to click the same button to 
perform the two call-control tasks.  
  

 

Transfer  
This feature performs a “blind” transfer (does not allow you to announce the call 
before performing the transfer).  

 

Consult Transfer 
This feature allows you to announce the call before completing the transfer. 
  

 

Direct Transfer 
This feature is not active. 
  

 

Join 
This feature is not active. 

 

 

Park/Revert Park  
Note This Call Control button toggles, allowing you to click the same button to 
perform the two call-control tasks.  
When you park a call, the call will transfer to the Parked Calls area of the screen.  
When the call is reverted/retrieved, the call will move from the Parked Calls box 
and appear in the Call Control box of the attendant handling the call. 
 

 

Conference 
You can initiate a conference call from any menu and add another party using the 
speed dial or directory listings. 

 

Forward a Call to Voice Mail 
When you select this button, the caller will be put on hold.  You will see a dial pad 
for entering the number you want to contact (the one to receive the voicemail 
message). 

 
 Note   In addition to using the Call Handling bar to invoke commands, you can 
also right-click on the call and activate a command menu and select the option 
of choice to invoke.  These options are also available from the Actions menu. 
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Call Handling from Your Phone 
You can perform many of the tasks on the Call Handling bar on your phone.  
These include Park, Call Transfer, Hold/Resume, End Call, Dial, Answer, and 
Conference Call.  To perform these functions, refer to the appropriate section of 
this user’s guide. 

Creating Speed Dial Lists & Speed Dial Groups 
You can create a personal speed dial list or speed dial groups in Assistant 
Console.  This can serve as your “personal phone book”.   

Creating a Speed Dial Entry 

To add a speed dial number, you can right-click from the Speed Dial screen to 
pull up a menu and select Add Speed Dial. 

 

From the Add Speed Dial box, enter the name, number, and any notes.  To save 
this entry and continue to enter additional entries, press Save. To save this entry 
and exit the Add Speed Dial box, press Save and Close. 

To edit or delete a speed dial entry, select either Edit or Delete.  If you are 
editing a speed dial entry, modify the appropriate items and press Save. 
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Creating a Speed Dial Group 

To create a speed dial group, right-click from the Sample Group tab on the 
Speed Dial screen. From the sub-menu, select New Speed Dial Group. 

 

From the New Speed Dial Group menu, enter the name for the new speed dial 
group and select Save.  You can also rename or delete speed dial groups as 
needed by selecting those choices. 

Using Edit on the Menu Bar to Add Speed Dials for Speed Dial Groups 

You can also select Edit from the menu bar and then select Speed Dials to add, 
edit, or delete a speed dial entry.  The ability to create, rename, or delete speed 
dial groups can also be accessed through the Edit menu. 
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Managing Speed Dial Lists 
You can sort the speed dial list by name, telephone number, or notes.  To 
change the sort order of the speed dial list, click on the appropriate heading.  The 
primary sort will have a triangle in the header box. 

You can add names into your speed dial list directly from the Directory.  Search 
the desired name, select the name, and drag and drop it into the speed dial list 
(and desired speed dial group, if applicable). 

Making Calls Using Speed Dial Lists 
You can use your speed dial list to make calls in one of three ways: 

• Double click on the highlighted speed dial entry.   
• Drag the desired speed dial entry to your line.   
• Drag the desired speed dial entry to your dial button and press OK. 

Using the Directory 
You can search the Directory online in Attendant Console.  You can search by 
first or last name, or partial first or last name.   

 

To place a call directly from the Directory results, highlight the name of the 
person you want to call and double click on the highlighted row.  If you want to 
blind transfer a call to someone in the directory, locate the desired person and 
then drag and drop the active call on the appropriate search result. 
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Understanding the Status Bar 
The status bar is located in the bottom right-hand corner of the Assistant Console 
screen.  This bar displays the following status symbols: 

• Pop-to-Top Icon: This allows you to quickly display the Call Control 
window when receiving or placing a call and when the window is 
minimized. 

• Call Control Up/Call Control Down: Indicates  the status (Trying, Call 
Control Up) 

• Online/Offline: Indicates whether or not you are available to handle calls.  
You must be both connected and online to handle calls. 

• IP Address: The IP address or hostname of the attendant server. 

Going Offline or Logging Off 
If you need to go offline, select the Attendant icon from the Call Handling bar.  
The icon will change and the status bar will indicate offline.  You can also go to 
File on the menu bar and select Go Offline. 

To log off, go to File on the menu bar and select Log Out. 
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Configuring Speed Dial Buttons 
In addition to using Attendant Console to program speed dial lists, you can create 
a speed dial list from the Cisco CallManager tool.   

Step 1   Using a web browser on your desktop computer, log in to the 
Cisco CallManager utility by going to http://www.saddleback.edu/itc/ITCIPP.html 
and selecting the Cisco CallManager link.  
This will automatically take you to the Log on screen.   
 
Step 2 Log in using your first initial and last name, i.e., cfox (for Catherine Fox).  
Your temporary password is 123456.  (It is recommended that you change this for security 
reasons.) 
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Step 3   Click "Update your Speed Dial buttons/Print your button template" from 
the list of available configuration options. 
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Step 4   Enter the phone numbers and display text you want to associate with 
your speed dial buttons.  Remember to enter external numbers in the “9+1+area 
code+number” format.   

 

Step 5   When you are done, click Update to store your settings, or to restore 
your previous settings, click Cancel before clicking Update. 

Step 6   Print a copy of your Speed Dial list. Click Log off to exit.   

 Note   Be sure to enter the numbers exactly as you would if you were to call that number. For example, 
include an access code such as "9+1+area code” for external numbers. 

 

Using Speed Dial to Make Calls 
Step 1   Using the keypad, press the Speed Dial number you want to dial.   

Step 2   Select the AbbrDial soft key.  The number being called will be displayed 
on your LCD screen. 
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Unity Voicemail
 

Unity is the voicemail package that was selected for the Cisco IP Phone 7960.   
You may access Unity in the following two ways: 

• Internally – Press the messages  button on your phone. 
• Externally- Dial 949-348-6099. 
• Your default password is 723686#. For security reasons, you must change your password as soon 

as possible. 
• Your password has to be a minimum of 4 digits. 

o You cannot use: 
 Digits that are the same, i.e. 66666 
 Digits that are sequential, i.e. 5678 
 Digits that are the same as your extension 
 Digits that spell your name. 

• Your ID (if requested by the system) is the same as your extension number. 

 

Setting Up Your Voicemail 
Internally  

Step 1 Press the messages  button on your phone and follow the voice instructions. 

Step 2 Listen to the menu and follow the voice instructions. 

Remotely 

Step 1 Dial 949-348-6099. 

Step 2 Press the “ * “ (asterisk) button when Unity answers. 

Step 3 Enter the ID (your extension number, then press “ # “ (pound sign button)  

Step 4 Listen to the menu and follow the voice instructions. 
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Accessing Your Voicemail 
Internally 

Step 1 Press the messages  button on your phone and follow the voice 
instructions 

Step 2 The red light on your handset lights when you have a voicemail message. 
The LCD also displays a text message indicating the number of voicemail 
messages in your inbox. 

Remotely 

Step 1 Dial 949-348-6099. 

Step 2 Press the “ * “ (asterisk) button when Unity answers.  

Step 3 Enter your ID (your extension number) then press “ # “ (pound sign 
button) 

Step 4 Listen to the menu and follow the voice instructions. 
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Record a Greeting 
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Check Messages 
* Note: Old messages are not deleted automatically. Delete unwanted messages 
frequently to save space.  
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Reply to a Message 
You can reply by phone only to messages from other people in the same 
voicemail system (e.g. from people on the Saddleback or Irvine campuses or in 
the District office).  You cannot reply to messages from people who call in from 
other locations (e.g. vendors).  
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Forward a Message 
You can forward a message as is, or record an introduction that plays before the 
forwarded message. When addressing a message, press the “ # “ key twice (# #) 
to switch between spelling mode (name of person) and number mode (their 
extension). 

You can forward messages from other people in the same voicemail system (e.g. 
from people on the Saddleback or Irvine campuses or in the District office).  You 
cannot forward messages from people who call in from other locations (e.g. 
vendors).  
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Send a Voice Message 
When addressing a message, press the “ # “ key twice (# #) to switch between 
spelling mode (name of person) and number mode (their extension). 
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Change Your Password 
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Playback Volume of Message 
As you listen to a message by phone, you can adjust the volume of the message. 
The change does not affect the playback volume of other messages. You cannot 
adjust recording volume or the playback volume of greetings.  

 

5 
5 

5 
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Change Your Recorded Name 
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